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WELCOME TO SITEPLANNER PRO!

SitePlanner Pro™ is today’s first desktop application for creating residential site plans!  Its

simple, user-friendly features provide everything you need to quickly construct new site plans

and then update them with a few simple mouse clicks.  SitePlanner Pro also requires no

architectural or surveying experience!  Creating a site plan is as easy as one, two, three . . .

1. Define the boundaries of the site.  Here you will specify the outside dimensions of the

site.  You can either transfer existing information from a surveyor’s blueprint or enter the

dimensions from scratch.  As you define the site boundaries, SitePlanner Pro automatically

draws them on the screen!

2. Define the site properties.  In this step, you’ll specify the desired lot sizes and the width

of right-of-ways (roads plus frontage easements).

3. Design the site.  This is where the fun really begins!  Using SitePlanner Pro’s simple point-

and-click features, you’ll add entrances, right-of-ways, cul-de-sacs, and undeveloped areas

to your site.  SitePlanner Pro then automatically plots the lots along the right-of-ways.

After completing the site plan, you can quickly add new features, or you can modify or

delete any of the original site features with a few simple clicks of the mouse!

Site Statistics. An on-screen display provides detailed information about the site plan you’re

creating, including the total length of right-of-ways, the total number of lots on the site, and
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the total square footage allocated to lots, right-of-ways, and undeveloped areas.  The program

can also display a graph that shows what percentage of the overall site is allocated to lots,

right-of-ways, and undeveloped areas.  This information is automatically updated and displayed

while you’re creating the site plan, which provides you an ongoing summary of vital site

statistics!

Color-coding. SitePlanner Pro also lets you color-code different types of lots, such as wooded,

waterfront, sold, or available.  Similarly, you can color-code different types of undeveloped

areas, such as retention ponds, lakes, and wildlife preserves.  You can also add notes or other

text designations anywhere on the site plan!

Ready to get started?  We’ll first define the conventions we use in this manual.  Then we’ll

look at the hardware and software required to run SitePlanner Pro.  Finally, we’ll install

SitePlanner Pro and you’ll be ready to create your first site plan!

TECHNICAL SUPPORT

If you need help installing or using SitePlanner Pro, please email us at the following address for

prompt assistance:  support@siteplanner.com

mailto:support@siteplanner.com
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CONVENTIONS USED IN THIS MANUAL
• Menu titles, menu selections, icon names, and field names all appear in Bold Type.

• Window names appear in regular typeface with initial capital letters.

• Unless otherwise specified, press the left mouse button wherever the manual says to click

or to click-and-drag.

• The term click-and-drag means to hold down the left mouse button and drag the mouse to:

(a) move the on-screen cursor over a particular menu selection, or (b) move an on-screen

object such as a road or an undeveloped area to a different location on the site plan.  When

the desired menu selection is highlighted or when the object being moved is in the desired

location, release the mouse button.

• The various objects on site maps include right-of-ways (roads), lots, undeveloped areas, and

notes.
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SYSTEM REQUIREMENTS

You need the following hardware and software to run SitePlanner Pro.

• Hardware

A personal computer with a 486 or higher CPU is required.

A personal computer with a Pentium 133 MHz (or faster) CPU is recommended.

• Monitor Resolution

A monitor with 800 x 600 dpi or higher display resolution is recommended.

• Operating System Software

Microsoft Windows 95 (or higher)  OR  Microsoft Windows NT 4.0 (or higher) is required.

INSTALLATION

Do the following steps to install SitePlanner Pro.

1. Insert the SitePlanner Pro CD in any available CD-ROM drive.  The following window is

displayed.
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SitePlanner Pro CD Window

2. Double-click on the Setup.exe icon.

3. Follow the installation instructions displayed on the screen.
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PROGRAM PERFORMANCE

You will gain maximum program performance by turning off the display of lots (View menu,

Hide All Lots option.)  On slower machines, dragging roads around gets really slow when all of

the lots are visible, because the program recalculates where the lots should be each time you

move a road.  If you turn off the lots, you can move and reshape roads more quickly.

USING SITEPLANNER PRO

The Installer program places SitePlanner Pro on your Program menu.  You’ll are using either a

"Lite" version or "Release" version of the program.

The "Lite" version offers full functionality except for DXF import and export functions.

The "Release" version offers full SitePlanner Pro functionality, including DXF functions.

However, the SitePlanner Pro CD must be installed in any available CD-ROM drive to execute

program functions Save, Save As, and Print.  If you try to save or print a site plan when the CD

is not installed, the following dialog box is displayed.
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Warning Dialog Box

Insert the SitePlanner Pro CD into any available CD-ROM drive and click on the OK button in

the dialog box.  The Save, Save As, or Print function is now executed.  We suggest that you

leave the SitePlanner Pro CD in the CD-ROM drive whenever you’re using the program!

FILE MANAGEMENT

This section describes the standard file management functions available on the File menu,

which is illustrated below.
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Options on the File Menu

New -

Select this option to create a new SitePlanner Pro file.  The Boundary Definition window is

displayed.  The section entitled +Define the Site Boundaries provides detailed information

about this window.

Open -

Select this option to open an existing SitePlanner Pro file.  If you’re working on another site

plan, the system prompts you to save it.  After saving, a standard Windows Open dialog box is
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displayed.  Specify the drive, path, and folder that contains the file you want to open.  Then

select the file and click on the Open button.

Save -

Select this option to save the SitePlanner Pro file you’re working on.  A standard Windows

Save dialog box is displayed the first time you save a new SitePlanner Pro file.  Assign a file

name and specify the drive, path, and folder where you want to save the file.  Then click on

the Save button.

Save As-

Select this option to make a copy of the SitePlanner Pro file you’re working, assign it a new

name, and then save it.  A standard Windows Save As dialog box is displayed.  Type the name

that you want assigned to the new file and specify the drive, path, and folder where you want

to save the file.  Then click on the Save button to save the file.

Import DXF-

DXF,  Data Exchange Format, is a powerful import feature you can use to import your site plans

from a CAD program and into SitePlanner Pro.  When you select this option, the standard open
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dialog box appears from which you can select a file to import.  The default extension of the

file is .dxf.

Important Note: to correctly import a dxf file, it should contain only a site boundary.  The

boundary can be created in a CAD program using either individual line segments or a polyline.

The file cannot contain any lines or polylines that are not part of the boundary.  If it does,

the file will not import correctly.

Export DXF-

DXF,  Data Exchange Format, is a powerful export feature you can use to export your site

plans from SitePlanner Pro and into a CAD program.  A robust export option, you control

exactly how a site plan is exported.  You select your DXF export settings by selecting the

option DXF Settings.

DXF Settings-

DXF uses layers to represent the different parts of your site plan.  During DXF export, you have

a choice of selecting how the layers of a site are exported: Single, Default, or Custom.

Single: exports the site plan in one (1) layer (everything together).
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Default: exports each part of the site plan (i.e., boundary, roads, lots, undeveloped lakes,

retention areas, and conservation areas) separately – in their own layer.

Custom: you select how you want to export each part of the site.  For example, you can

export certain parts together like roads and lots as one layer and lakes and retention areas as

one layer.

DXF Export Settings Window
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Also during export, you can select a color to represent a layer.  DXF supports 8 colors.

Print -

Select this option to print the SitePlanner Pro file you’re working on.  A standard Windows

Print dialog is displayed.  Ensure that the desired printing information is displayed and click on

the OK button.

Exit -

Select this option to close the current file and quit SitePlanner Pro.  You will be prompted

whether or not you want to save the file.  Click on Yes.  The file is saved and SitePlanner Pro

exits.

CREATING A NEW SITE PLAN

Select the SitePlanner Pro application from the Program menu.

SitePlanner Pro is loaded and the Main Window is displayed.

You must now complete three easy tasks to create a new site plan:

1. Define the Site Boundaries

2. Define the Site Properties



SitePlanner Pro User Guide 16 Version 2.1

3. Design the Site

Step-by-step instructions for completing these tasks appear below.

Keep the following tips in mind when creating or modifying a site plan.

QUICK TIPS
• If you double-click on a tool in the drawing palette, it will remain active (selected) after you

use it.

• If you click once on a tool in the drawing palette, after you use it the program will revert to

the Selection tool.

• With the Selection tool highlighted in the drawing palette and no objects selected, double-

click on any road or cul-de-sac to modify its properties.

• With the Selection tool highlighted in the drawing palette and no objects selected, click on

one or more roads and/or cul-de-sacs.  Then right-click on any highlighted object and select

Properties from the pull-down menu.  Enter a new value for the Road Width or Cul-de-sac

Radius and press the OK button.  The new properties you specified now apply to the

objects you selected.
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QUICK TIPS continued
• With the Selection tool highlighted in the drawing palette and no objects selected, right-

click on any road or cul-de-sac and select Properties from the pull-down menu.  Change the

Road Width or Cul-de-sac Radius value, as desired, and press the OK button.  The new

value(s) will apply to all roads (and/or cul-de-sacs) that are added to the site plan from this

point on.

When you’re creating or moving roads and cul-de-sacs, sometimes one or more lots will be

displayed in red.  This indicates that the designated lot(s) do not meet the frontage, depth,

or area properties that were defined.  Take one or more of the following actions to

correctly display these lot(s):

a) change the frontage, depth, and/or area properties,

b) change the angle of intersection of one or more intersecting roads, or

c) change the length of a road.
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A. DEFINE THE SITE BOUNDARIES

Task Overview

The following paragraphs describe the boundary definition task.  The Boundary Definition

window is automatically displayed when you open a new site plan from the File menu.  In this

window, you will specify the boundaries (i.e., the outside dimensions) of the land parcel

you’re plotting.  You must specify these boundaries before you can plot the right-of-ways,

lots, and other features in your site plan.

The site boundaries are defined as a series of connected lines (called boundary lines) around

the perimeter of the land parcel.  You must first specify the bearing (direction of travel),

length, and type (straight or curved) of the first boundary line.  The software then draws this

boundary line in the Current Boundary box, which is located in the lower right-hand corner of

the Boundary Definition window.  (If you change any of the specified information for this

boundary line, the system automatically updates the corresponding boundary line displayed in

the Current Boundary box.)  You must repeat this process for each boundary line until the

entire perimeter of the land parcel has been drawn.  This task takes a little time, but once it’s

done, constructing the rest of the site plan is very easy!

Observe the diagram below.  Boundary information is entered and displayed in the top area of

the window, which is called the boundary information area.  Each row in this area specifies
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information about one boundary line along the perimeter of the site.  The information initially

displayed in this area describes the first boundary line that you will plot.  This displayed

information serves as a starting point only and usually has to be modified.

Click on the buttons in the Boundary Definition window to perform the following activities:

Add – Inserts a new row of boundary information below all the currently displayed boundary

information.

Insert – Adds a new row of boundary information above the selected (highlighted) row.

Delete – Deletes the selected row of boundary information.

OK – Saves all boundary additions and changes that you have made during this boundary

definition session (i.e., since the Boundary Definition window was last displayed).

Cancel – Deletes all boundary additions and changes that you have made during this boundary

definition session.

Revert – Cancels all new and modified information made during this boundary definition

session.  The boundaries displayed in the Current Boundary box are changed to the

boundaries displayed in the Previous Boundary box.
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First Row of
Boundary Line

Information
→

                       Boundary Definition Window
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Keep the following points in mind regarding the Boundary Definition window and the

information displayed in this window:

• Each row of information in the upper portion of the window describes one boundary line

along the perimeter of the site.

• The currently selected row of boundary information is highlighted.

• The currently selected field in (the selected row) is highlighted in a darker color.

• The system automatically draws a boundary line in the lower left-hand corner of the

window that corresponds to each row of boundary information.

• The boundary line (in the Current Boundary box) that corresponds to the currently

selected row of boundary information appears in blue.

• Each new boundary line begins at the end of the last boundary line that was drawn.  This

results in a continuous boundary around the site.

Do the following procedure to define the site boundaries.

Boundary Definition Procedure

1. Select New from the File menu.  This instructs the program to create a new site plan.
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Main Window with the File Menu Expanded

The Boundary Definition window is displayed.
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Boundary Definition Window

2. Click on the Add button.  A row of boundary line information is displayed near the top of

the window, as shown below.



SitePlanner Pro User Guide 24 Version 2.1

Location of Boundary Line Information

The following illustration shows the default boundary information that the system displays

for the first boundary line (along the site’s perimeter).  Do steps 3–7 to define this

boundary line.
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Boundary Line Information

3. Select a line type from the Type field.

The default selection is a Straight line, which is represented by the top icon in the diagram

below.  To select a different line type, double-click on the icon displayed in the Type

field.  Drag the cursor to the desired line type icon in the pull-down menu and click once.

The selected icon (representing the desired line type) now appears in the Type field.

You can select one of three line type icons, which appear in the following sequence in the

pull-down menu:
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←  Currently Selected Line Type

←  Straight line (default)

←  Curved line – Bearing applied to start of line

←  Curved line – Bearing applied to end of line

Selecting a Line Type

4. Define a bearing for the boundary line you are drawing.

The data in the Bearing field, highlighted in the illustration below, corresponds to the

standard bearing information that appears on architectural blueprints.  In SitePlanner Pro,

the bearing information specifies the direction in which the line will be drawn.  The

bearing information consists of two parts – a primary direction and an offset.

Primary Direction – The first character in the Bearing field specifies the primary direction.

It must be N or S (North or South).  This designation specifies the initial direction in which

the line will be drawn.  In the example below, the primary direction is North.  If no offset is

defined, a straight vertical line will be drawn in an upward (Northbound) direction.
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Offset – The other data in the Bearing field specifies an offset from the primary direction.

In the default parameter displayed by the system, this data is 90˚0'0"E.  This data tells the

system that the line it draws should be rotated 90˚ East (clockwise) of the primary

direction (North).  This will result in a horizontal line being drawn due east from the

starting point.

Bearing Field

5. To change either of the displayed values (the primary direction or the offset), double-click

on the data displayed in the Bearing field.  Five data entry boxes are now displayed in this

field, as shown in the following diagram.

Bearing Data Entry Boxes
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The left-most data entry box specifies the primary bearing direction.  It can be either N or

S (North or South).  To change the current value, position the cursor over the displayed

value, and click-and-drag to the desired value on the pull-down menu.  The selected

primary direction is activated and the standard information display returns to the Bearing

field.

Changing the Primary Direction

The three center data entry boxes define the bearing offset value in degrees, minutes, and

seconds, respectively.

To change the current value in any of these boxes, double-click on the displayed value to

highlight it, and then type the desired value.

Changing the Bearing Offset Value
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If desired, you can repeat this step to edit the value in any of the three data entry boxes.

To move to another data entry box, you can either double-click on the value you want to

change or you can press the Tab key to move between fields.  (In addition to the data

entry boxes, the Tab key also sequences the active field through all of the buttons in the

Boundary Definition dialog box.)

When you have made all the necessary changes to the three center data entry fields, press

the Return key.  The new information is displayed in the Bearing field for this boundary

line.

The right-most data entry box contains the bearing offset direction, which is a deviation from

the primary bearing displayed in the left-most box.  The offset direction can be either E or W

(East or West).  To change the current value, position the cursor over the displayed value,

and click-and-drag to the desired value on the pull-down menu.  The selected bearing offset

direction is activated and the standard information display returns to the Bearing field.

Changing the Bearing Offset Direction
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6. Specify the length of the boundary line.

The value displayed in the Length field (highlighted in the following illustration) specifies

the length (in feet) of the boundary line that will be drawn.

Length Field

To change the value displayed in the Length field, double-click on it.  A data entry box is

displayed, as shown below.  Double-click on the value in the box to highlight it, enter the

desired value, and press Return.  Then click on any field except the Length field.  The new

value is now displayed in the Length field.

Changing the Boundary Line Length
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7. (OPTIONAL) Enter a radius specification.

IMPORTANT

This field is only specified when you are entering specifications for a Curved line.

The Radius field specifies the amount of curvature in the curved line being drawn.

To understand this parameter, imagine an arbitrary curved line (i.e., an arc).  Extend the

line until it makes a full circle.  The Radius parameter defines the distance from the center

of this imaginary circle to any point on the circle.

• A shorter radius (i.e., a lower Radius value) will increase the curvature of the line being

drawn.  This could also be thought of as a more rounded curved line.

• A longer radius (i.e., a higher Radius value) will decrease the curvature of the line being

drawn.  This could also be thought of as a flatter curved line.

This principle is illustrated in the diagram below.  A radius setting of 500 feet will provide

an arc similar to the one on the left.  A radius setting of 1,000 feet will result in a much

flatter arc, like the one on the right.
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Current Boundary Current Boundary

Effect of the Radius Setting

The following diagram illustrates a row of boundary information for a curved line, with the

Radius field highlighted.  The value in the Radius field specifies the direction (Left or Right)

and length (in feet) of the radius for the curved line that will be drawn.

Radius Field



SitePlanner Pro User Guide 33 Version 2.1

To change either the direction or the length of the radius, double-click on the Radius

field.  The data entry boxes shown in the diagram below are now displayed in the Radius

field.

Data Entry Boxes for the Radius Values

To change the radius direction, position the cursor over the displayed value, and click-and-

drag to the desired value on the pull-down menu.  The selected radius direction now

appears in the data entry box.

To change the radius length, position the cursor over the displayed value and double-click

to highlight it.  Enter the desired value for the radius length, and either press Return or

click on any other field in the current row.  The specified radius length now appears in

Radius field.
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You have now defined all the required information for this boundary line.  The program

automatically draws this boundary line in the Current Boundary window, as shown in the

following diagram.  (This illustration shows the plot for a straight line.)

Boundary Definition Window
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8. Repeat steps 2–7 to define each boundary line along the perimeter of the site.  Continue

this process until the entire perimeter of the site has been specified.  When the program

plots the boundary lines in the Current Boundary window, each new boundary line will

start at the same point that the previous boundary line ended.  The completed boundary

will be a continuous series of lines around the entire perimeter of the site.  The following

diagram shows an example of a completed boundary in the Current Boundary window.

Sample Boundary Display

9. When you’ve defined the entire boundary, click on the OK button.  All the information you

entered is saved and an image of the completed boundary appears in the Previous

Boundary area, as shown in the diagram above.  The Main Screen is now displayed.
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B. DEFINE THE SITE PROPERTIES

Task Overview

During this task, you will define the width of all right-of-ways in the site, the default lot

dimensions, and the maximum and minimum allowable total lot areas.  SitePlanner Pro uses this

information to draw roads, cul-de-sacs, and lots on the site plan.

IMPORTANT

• The properties you define for a particular class of objects (roads, lots, etc.) before you

create a site plan apply to all objects on the site plan.

• You can change the property definitions for a class of objects any time after you begin

creating the site plan.  If you do this, the new properties you define will apply only to new

objects you create after the change.  All objects that you created using the original

properties will keep the original properties.  At any time, you can also select a group of

objects and change their properties.

Property Definition Procedure

NOTES

• The term right-of-way appears as ROW in several screens and dialog boxes.
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• After changing any property, you can immediately see the effect of the change by

clicking on the Apply button, which will update the site plan.  The Properties

dialog box remains displayed.

1. Select Properties from the Edit menu, which is shown below.

Edit Menu

The Properties dialog box is displayed, with the ROW tab selected.  Default values for Road

Width and Cul-de-sac Radius are displayed, as shown in the following diagram.
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ROW Values

• The Road Width specification includes the width of the road plus the width of all

frontage easements on both sides of the road.
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• The Cul-de-sac Radius specification includes the radius of the circular road (the

distance from the center point of the cul-de-sac to any point on its circumference)

plus the width of any frontage easement abutting the cul-de-sac.

2. To change a displayed value, double-click on it.  Enter the desired value for the highlighted

data and press Return.  The new value is now active.  If necessary, repeat this step for the

other displayed value.

3. Click on the Frontage tab in the Properties dialog box.  Minimum, Maximum, and Default

values for lot frontage (lot width) are displayed, as shown in the following diagram.
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Frontage Values

4. To change a displayed value, double-click on it.  Enter the desired value for the highlighted

data and press Return.  The new value is now active.  If necessary, repeat this step for the

other displayed values.

5. Click on the Depth tab in the Properties dialog box.  Minimum, Maximum, and Default

values for (lot) depth are displayed.
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Depth Values

6. To change a displayed value, double-click on it.  Enter the desired value for the highlighted

data and press Return.  The new value is now active.  If necessary, repeat this step for the

other displayed values.

7. Click on the Area tab in the Properties dialog box.  The Normal Lot button is selected by

default.  Minimum and Maximum values for the total Normal Lot area are displayed.
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NOTE

When this dialog box is displayed, either the Normal Lot or Corner Lot button will

be selected.  Whichever button was last selected remains selected at this time.

Do step 7 to specify area values for a Normal lot.

Area Values for a Normal Lot
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8. To change a displayed value, double-click on it.  Enter the desired value for the highlighted

data and press Return.  The new value is now active.  If necessary, repeat this step for the

other displayed value.

9. To change the total lot area specifications for a corner lot, click on the Corner Lot button

in the Properties dialog box.  Minimum and Maximum values for the total corner lot area

are displayed, as shown in the following diagram.
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Area Values for a Corner Lot

10. To change a displayed value, double-click on it.  Enter the desired value for the

highlighted data and press Return.  The new value is now active.  If necessary, repeat this

step for the other displayed value.

You’ve now defined all required Site Properties and can design the Site Plan!
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C. DESIGN THE SITE

Task Overview

During this task, you will specify the location of entrances, straight and curved right-of-ways

(ROWs), cul-de-sacs, and undeveloped areas, such as woods, lakes, and retention ponds.  You

can then add textual notes anywhere on the site plan.  These site elements are specified

using the site design tools in the drawing palette located along the left side of main window,

as shown in the next illustration.

The tan area in the illustration represents the site.  The perimeter of this area corresponds to

the site boundaries you entered during Task A, Define the Site Boundaries.  All site elements

(with the exception of entrances) must be drawn totally inside the site.
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Main Window
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Site Statistics

As you add elements to the site plan, the system keeps track of detailed statistics about the

site, including the total length of right-of-ways, the total number of lots on the site, and the

total square footage allocated to lots, right-of-ways, and undeveloped areas.

To display the current site statistics, select Statistics from the Site menu, which is shown

below.

Site Menu

The system displays the following dialog box, which you can leave on the screen while you’re

creating the site plan.  The displayed field values are automatically updated as you modify the

site plan, which provides you an ongoing summary of vital site statistics.
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Site Statistics Dialog Box

You can also display a graph that shows what percentage of the overall site is allocated to lots,

right-of-ways, and undeveloped areas.  To do this, click on the Show Graph button in the Site

Statistics dialog box.  A pie chart style graph is added to the dialog box, as shown below.
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Site Statistics dialog box with graph
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Site Design Tools

The following site design tools (shown below) can be selected from the drawing palette on the

left side of the main window.  You will be using these tools to add various objects to the site

plan.  The tools (from top to bottom on the pallette):

• Selection tool – for selecting an existing element you want to edit or delete

• Straight Road tool – for creating straight roads on the site plan

• Curved Road tool – for creating curved roads on the site plan

• Cul-de-sac tool – for creating cul-de-sacs on the site plan

• Undeveloped Area tool – for creating undeveloped areas on the site plan

• Notes tool – for creating notes anywhere on the site plan

QUICK TIPS

• If you double-click on a tool in the drawing palette, it will remain active (selected) after you

use it.

• If you click once on a tool in the drawing palette, after you use it the program will revert to

the Selection tool.
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QUICK TIPS continued

• With the Selection tool highlighted in the drawing palette and no objects selected, double-

click on any road or cul-de-sac to modify its properties.

• With the Selection tool highlighted in the drawing palette and no objects selected, right-

click on any road (or cul-de-sac) and select Properties from the pull-down menu.  The

properties you now specify will apply to all roads (or cul-de-sacs) that are added to the site

plan from this point on.

• When you’re creating or moving roads and cul-de-sacs, sometimes one or more lots will be

displayed in red.  This indicates that the designated lot(s) do not meet the frontage, depth,

or area properties that were defined.  Take one or more of the following actions to

correctly display these lot(s):

a) change the frontage, depth, and/or area properties,

b) change the angle of intersection of one or more intersecting roads, or

c) change the length of a road.
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Adding a Straight Road (Right-of-Way)

1. In the drawing palette, click on the Straight Road tool, which is highlighted in the following

diagram.

2. Position the cursor at the location on the site plan where you want the road to begin.

3. Click-and-drag the cursor to the desired ending point of the road.  The straight road is

added to the site plan.

Observe the following diagram, which shows three straight roads on a site plan.  When you

first add a straight road to a site plan, it looks like the top example in the diagram.  The

gray area represents the road.  The white circle at each end of the road is called a control

point, which can be used to change the length or direction of the road.  You can also

think of control points as intersections, since they are also used to join two or more roads.

(This process is discussed later in the manual.)  The system automatically draws lots (the

brown squares) along both sides of the road.  (The size of the lots and the width of each

road conform to the information you specified during Task B, Define the Site Properties.)

4. To move any straight road on the site plan, position the cursor over the road.  The cursor

becomes a crossed-arrow tool, as shown in the center example on the diagram below.

Click-and-drag the road to the desired position.
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Moving a Straight Road
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5. To lengthen or shorten a straight road on the site plan, click on the control point at the
end of the road that you want to change, as shown in the top example below.  The control
point turns yellow (center example below), which indicates that it’s active.  Position the
cursor over the yellow control point and click-and-drag the end of the road to the desired
location.  The road is relocated and the lots on both sides of the road are re-plotted.
During this step, you can also rotate the end of the road to change its direction.

Changing the Length or Direction of a Straight Road
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Adding a Curved Road (Right-of-Way)

1. In the drawing palette, click on the Curved Road tool, which is highlighted in the following

diagram.

2. Position the cursor at the location on the site plan where you want the road to begin.

3. Click-and-drag the cursor to the desired ending point of the road.  A curved road is added

to the site plan.  (It initially looks like a straight road, but it really isn’t, as you’ll see in the

next few steps!)

Observe the diagram below, which shows two curved roads on a site plan.  When you first

add a curved road to a site plan, it looks like the top example in the diagram.  The gray

area represents the road.  The white circle at each end of the road is called a control

point, which can be used to change the length, direction, or curvature of the road.  The

system automatically draws lots (the brown squares) along both sides of the road.  (The size

of the lots and the width of each road conform to the information you specified in the

Properties dialog boxes earlier in this procedure.)

4. To move any curved road on the site plan, position the cursor over the road.  The cursor

becomes a crossed-arrow, as shown in the top example in the following diagram.  Click-and-

drag the road to the desired position.
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Moving a Curved Road
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5. To add curvature to either end of the road, position the cursor over the control point at

the end of the road that you want to modify.  When the cursor is correctly positioned, it

becomes a crossed-arrow, as shown in the bottom example below.  Click-and-drag the end

of the road to the desired position.  The modified road is redrawn on the screen with

curvature added, as shown in the bottom example below.  The lots along both sides of the

road are also re-plotted.
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Adding Curvature to the End of a Road

6. To add curvature to the center of the road, position the cursor over the control point at

the road’s midpoint.  When the cursor is correctly positioned, it becomes a white pointer,
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as shown in the top example below.  Click-and-drag the center of the road to the desired

position.  The modified road is redrawn on the screen, as shown in the bottom example

below.  The lots along both sides of the road are also re-plotted.

Adding Curvature to the Midpoint of a Road
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Adding a Cul-de-sac

1. In the drawing palette, click on the Cul-de-sac tool, which is highlighted in the following

diagram.

NOTE

A cul-de-sac may be added to either end of an existing road.  It cannot exist “alone.”

2. Position the cursor over the control point where you want to add the cul-de-sac, as shown

in the top example below.

3. Click once.  A cul-de-sac is added at the specified end of the road.  (The radius of the cul-

de-sac will be the length you defined in the Site Properties.)  The program automatically

plots lots along the cul-de-sac.
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Adding a Cul-de-sac
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Adding an Undeveloped Area

1. In the drawing palette, click on the Undeveloped Area tool, which is highlighted in the

following diagram.

2. Position the cursor at the location on the site plan where you want the undeveloped area

to begin.

3. Click-and-drag the cursor to make a rectangular object that is the approximate desired size

of the undeveloped area.  This object represents the undeveloped area.

4. To move the object, position the cursor over it.  The cursor becomes a crossed-arrow, as

shown in the top example below.

5. Click-and-drag the object to the desired location.
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Moving an Undeveloped Area
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6. To modify the shape of an undeveloped area, position the cursor anywhere on the

undeveloped area and click once.  A square control point appears in each corner of the

object, as shown in the top example in the following diagram.

7. Position the cursor over the control point in the corner that you want to move, as also

shown in the top example below.

8. Click-and-drag the control point to modify the shape of the object.  The new shape of

object  is displayed, as shown in the bottom example below.
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Modifying the Shape of an Undeveloped Area
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NOTE

Customizing the shape of a large undeveloped area may require additional control

points.  Do steps 9–11 to add or delete control points.

9. Position the cursor on the undeveloped area and right-click.  The following drop-down

menu is displayed.

Adding or Removing Control Points
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10. Select Add Control Point from the menu.  A new control point appears along the

perimeter of the currently selected undeveloped area.  Repeat this step, as necessary, to

add more control points along the perimeter of the undeveloped area.

11. Select Remove Control Point from the menu to delete a control point.  Repeat this step,

as necessary, to remove other control points.  Do steps 12-13 to display the dimensions for

an undeveloped area.
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 Displaying Dimensions
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12. Position the cursor on the undeveloped area and right-click.  A drop-down menu is

displayed.

13. Select the option Display Dimensions.  The dimensions of the area are displayed around

the boundary of the undeveloped area.

Defining Undeveloped Area Types

You can define various types of undeveloped areas in the site, such as retention, lakes, woods,

etc.  You do this by assigning a different color to each type of undeveloped area.  Do the

following procedure to create various types of undeveloped areas.

1. Select Undeveloped Area Types from the Site menu.

Site Menu
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The Undeveloped Area Types dialog box is displayed, as shown below.  All previously

defined undeveloped area types appear in the list box in the top left-hand corner.  In the

example below, “Lake” and “Wildlife Sanctuary” have been previously defined.

Defining Types of Undeveloped Areas

2. To define a new undeveloped area type, click on the Add button and type a name for the

undeveloped area type in the field that displays the words “New Type.”
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NOTE

You must now specify the color in which the undeveloped area type objects will

be displayed on the site plan.

• To select one of the colors that appear in the top right-hand corner of the

Undeveloped Area Types dialog box, do step 3 and then skip to step 11.

• To define a custom color, skip to step 4.

3. Click on a color in the top right-hand corner of the dialog box.  The color you selected

appears in the small square box on the left side of the Name field.  Objects representing

this type of undeveloped area will be displayed in the selected color on the site plan.  Skip

to step 11.

4. Click on the Custom Color button in the Undeveloped Area Types dialog box.  The Custom

Color dialog box (shown below) is displayed.

NOTE

You can select a custom color in either the HSB or RGB color space.  Either the

HSV or RGB tab at the top of the Custom Color dialog box is highlighted to

indicate the active color space, which will be the last color space selected.  Steps

5 and 6 describe the process for selecting a custom color in the HSB color space.
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If you wish to specify a custom color in the RGB color space, click on the RGB

tab and skip to step 7.

Custom Color Selection – HSB

5. Position the point of the cursor on the desired color in the circular color wheel and click

once.  Values for the hue, saturation, and brightness components of this color are

displayed in the H, S, and B fields, respectively.
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6. If you decide to select a different color, click on the Reset button and repeat step 5.

After you select the color, skip to step 10.

7. Position the point of the cursor on the Red slider in the dialog box.  Click-and-drag the

slider to the desired value on the scale.

8. If you decide to select a different color, click on the Reset button and repeat step 7.

Custom Color Selection – RGB

9. Repeat steps 7 and for the Green and Blue sliders.
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10. Click on the OK button.

The selected color is assigned to the undeveloped area type you’re defining and the

Undeveloped Area Types dialog box is displayed.  The color you selected appears in the

small square box on the left side of the name you specified for the undeveloped area

type.  Objects representing this type of undeveloped area will be displayed in the

specified color on the site plan.

11. Press the Return key.

The name you assigned is added to the list box.
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Undeveloped Area Types Dialog Box

12. To specify another undeveloped area type, repeat steps 2–11.

To move the name of an undeveloped area type upward or downward in the list box, click

on the name to highlight it, and then click on the Move Up or Move Down button.

To delete an undeveloped area type, click on its name in the list box and then click on

the Remove button.
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When you have defined all desired undeveloped area types, click on the OK button to save

the information and exit this function.

Assigning Undeveloped Area Types to Objects on a Site Plan

This function enables you to color-code specific objects on the site plan as being a particular

type of undeveloped area, such as woods or lakes.  The individual objects will then be

displayed in the color you specified for that type of undeveloped area during the preceding

Defining Different Types of Undeveloped Areas procedure.  (You must complete that

procedure before you can do this function.)

1. Click on one or more undeveloped area objects that you want to designate as being a

particular type.

Hold down the Shift key to select multiple undeveloped areas.  The selected objects are

highlighted on the screen.

2. Right-click-and-drag to select the desired undeveloped area type from the pull-down menu,

as shown in the following diagram.
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Selecting an Undeveloped Area Type
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The highlighted objects now appear in the color specified for the selected type of

undeveloped area.  You can do this procedure at any time to reassign a type designation to

any undeveloped area.

MANIPULATING ROADS AND OTHER SITE FEATURES

Creating an Entrance

This sequence creates an entrance to the site.  Although it can be moved, it always remains

an entrance (as opposed to a standard right-of-way).  If you want to change an entrance to a

standard right-of-way, you must delete it and create a new right-of-way.

1. Add a new straight road or curved road to the site.  When you draw the road, locate one

end of the road outside the site boundary (the tan area on the screen), as shown in the

first diagram below.

The end of road positioned outside the site boundary becomes the site entrance.  On the

site plan, it will be located at the edge of the site boundary, as shown in the second

diagram below.
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Creating an Entrance
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Appearance of an Entrance on a Site Plan
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Adding a New Road Between Two Existing Roads

This sequence inserts a new road between the control points (at the ends) of two existing

roads.

1. Click on the Straight Road tool or the Curved Road tool in the drawing palette, which is

shown in the diagram below.

Drawing Palette

2. Position the cursor over the control point where you want the new road to begin.  (This

can be the control point at either end of an existing road.)
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3. Click-and-drag to the desired control point on the other road, as shown in the center

example in the following diagram.  (This can be the control point at either end of a second

existing road.)

The new road appears on the site plan, as shown in the bottom example in the following

diagram.  The program re-plots the lots along all three roads, as necessary.
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Adding a Road Between Two Existing Roads
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Joining Two Existing Roads

1. In the drawing palette, click on the Selection tool, which is highlighted in the diagram

below.



SitePlanner Pro User Guide 86 Version 2.1

Selection Tool

2. Position the cursor over the desired control point on the first road that you want to join.

The cursor becomes a crossed-arrow tool, as shown in the top example in the following

diagram.

3. Click-and-drag to the desired control point on the second road that you want to join, as

shown in the bottom example in the following diagram.

The two roads are joined.  The program re-plots the lots along both roads, as necessary
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Joining Two Existing Roads
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Intersecting a New Road with an Existing Road

This function lets you draw a new road from any point on an existing road.  This results in a

tee intersection of the two roads.

1. Click on the Straight Road or Curved Road tool in the drawing palette, which is shown

below.

Drawing Palette
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2. Position the cursor at the location in an existing road where you want the new road to

intersect, as shown in the diagram below.

Cursor Positioning
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3. Click-and-drag to the location you want the new road to end, as shown in the diagram

below.

Positioning the New Road
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The new road appears on the site plan.  The program draws lots along this road, as shown

in the diagram below.

Final Plot of the New Intersecting Road
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Deleting Roads, Cul-de-sacs, Undeveloped Areas, or Notes

1. In the drawing palette, click on the Selection tool, which is highlighted in the diagram

below.

Selection Tool

2. Click on the object you want to delete from the site plan.  To select multiple objects, hold

down the Shift key and click on the objects.

3. Press the Delete key or select Delete from the Edit menu.
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The selected object(s) are removed from the site plan.

Edit Menu

Customizing Roads and Cul-de-Sacs

Changing the Properties of Selected Roads or Cul-de-Sacs

This function lets you redefine the properties for selected roads and/or cul-de-sacs.

1. In the drawing palette, click on the Selection tool, which is highlighted in the diagram

below.
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Selection Tool

2. Position the cursor over the road or cul-de-sac of interest.  When the cursor becomes a

crossed-arrow tool, click to select the road or cul-de-sac.  (To select multiple roads

and/or cul-de-sacs, hold down the Shift key and click on the desired objects.)

3. When all desired roads and cul-de-sacs have been selected, right-click.

A pop-down menu appears, as shown in the following diagram.
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Changing the Properties of Selected Roads or Cul-de-Sacs

4. Select Properties from the menu.
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The system displays the Properties dialog box, as shown below.

Properties Dialog Box

5. Double-click on the Road Width or Cul-de-sac Radius value and type a new value.

6. To immediately see the effect of the change, click on the Apply button.
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The system updates the site plan.

7. To change the other value in the dialog box, repeat steps 5 and 6.

8. When all desired changes have been made, click on the OK button.

Changing the Properties of a Selected Road (Alternate Procedure) or Cul-de-Sac

This function lets you redefine the properties for a selected road or cul-de-sac.

1. Double-click on the road or cul-de-sac of interest.

The Properties dialog box is displayed, as shown below.
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Changing the Properties of a Selected Road or Cul-de-Sac

2. Double-click on the displayed Road Width or Cul-de-sac Radius value and type a new value.
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3. To immediately see the effect of the change, click on the Apply button.

The system updates the site plan.

4. To change the other value in the dialog box, repeat steps 2 and 3.

5. When all desired changes have been made, click on the OK button.

Changing a “Straight Road” to a “Curved Road” (or vice versa)

This function lets you change an existing straight road to a curved road.  It also lets you

change an existing curved road to a straight road.

1. In the drawing palette, click on the Selection tool.

2. Right-click on the road of interest. A pop-down menu appears, as shown in the following

diagram.
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Specifying Straight or Curved Roads
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Note that a checkmark does not appear next to the Curve option on the menu.  This

indicates that the selected road is a straight road.

3. Click on the Curve menu option.  A checkmark now appears next to the Curve option on

the menu.  This indicates that the selected road is a curved road.

4. To change a curved road to a straight road, repeat steps 1–3.  The checkmark next to the

Curve option on the menu is removed and the selected roads are changed to straight

roads.

Changing the Properties of all Future Roads or Cul-de-Sacs

Execute this function to change the properties of all new roads or cul-de-sacs that will be

created.

1. Click on the Selection tool (highlighted in the diagram below) in the drawing palette and

ensure that no objects are selected on the site plan.
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Selection Tool

2. Position the cursor on any road or cul-de-sac and right-click.

3. Select Properties from the pop-down menu displayed.
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Selecting the Properties Option
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The Properties dialog box (shown below) is displayed.

Properties Dialog Box

4. Double-click on the Road Width or Cul-de-sac Radius value and type a new value.
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5. To immediately see the effect of the change, click on the Apply button.

The system updates the site plan.

6. To change the other value in the dialog box, repeat steps 4 and 5.

7. When all desired changes have been made, click on the OK button.

All new roads and/or cul-de-sacs will conform to the properties you just specified.

MISCELLANEOUS TASKS

Adding Notes to a Site Plan

This function allows you to add text labels anywhere on the site plan.  This could be used to

annotate street names, lot numbers, or any other desired textual information.  Do the

following procedure to add a note to your site plan.

1. Click on the Note tool in the drawing palette (shown below), which is located on the left

side of the Main Window.
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Note Tool

2. Click on the location on the site plan where you want the note to appear.

A rectangular text box appears, as highlighted in the diagram below.
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Adding a Note
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3. Move the cursor over the text in the box.  It becomes a crossed-arrow tool, as shown

between the two text boxes in the preceding diagram.

4. Double-click to highlight the text in the box and type the text you want to appear in the

box.

5. Press the Return key.

The width of the text box expands to show all of the text you entered.

6. To move the box, position the cursor over it, and click-and-drag to the desired location.

Locking the Objects on a Site Plan

This option freezes all objects (roads, lots, cul-de-sacs, undeveloped areas, and notes) in their

current positions and prevents them from being accidentally moved.

To lock all objects in the currently displayed site plan, select Lock Site from the Site menu,

which is shown below.
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Site Menu

Defining Lot Types

You can color-code various types of lots, such as sold, available, wooded, or waterfront.  Each

defined lot type will then be displayed in the specified color on the site plan.  The procedure

for color-coding various lot types is almost identical to the procedure for color-coding various

types of undeveloped areas.

1. Select Lot Types from the Site menu.
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Site Menu

The Lot Types dialog box is displayed, as shown below.  All previously defined lot types

appear in the list box in the top left-hand corner.  In the example below, “Wooded” and

“Waterfront” have been previously defined.
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Defining Lot Types

2. To define a new lot type, click on the Add button and type a name for the lot type in the

field that displays the words “New Type.”

NOTE

You must now specify the color in which the lot type objects will be displayed on

the site plan.

• To select one of the colors that appear in the top right-hand corner of the Lot

Types dialog box, do step 3 and then skip to step 11.
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• To define a custom color, skip to step 4.

3. Click on a color in the top right-hand corner of the dialog box.  The color you selected

appears in the small square box on the left side of the Name field.  Objects representing

this type of lot will be displayed in the selected color on the site plan.  Skip to step 11.

4. Click on the Custom Color button in the Lot Types dialog box.  The Custom Color dialog

box (shown below) is displayed.

NOTE

You can select a custom color in either the HSB or RGB color space.  Either the

HSV or RGB tab at the top of the Custom Color dialog box is highlighted to

indicate the active color space, which will be the last color space selected.  Steps

5 and 6 describe the process for selecting a custom color in the HSB color space.

If you wish to specify a custom color in the RGB color space, click on the RGB

tab and skip to step 7.
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Custom Color Selection – HSB

5. Position the point of the cursor on the desired color in the circular color wheel and click

once.  Values for the hue, saturation, and brightness components of this color are

displayed in the H, S, and B fields, respectively.

6. If you decide to select a different color, click on the Reset button and repeat step 5.

After you select the color, skip to step 10.
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7. Position the point of the cursor on the Red slider in the dialog box.  Click-and-drag the

slider to the desired value on the scale.

8. If you decide to select a different color, click on the Reset button and repeat step 7.

Custom Color Selection – RGB

9. Repeat steps 7 and 8 for the Green and Blue sliders.

10. Click on the OK button.



SitePlanner Pro User Guide 117 Version 2.1

The selected color is assigned to the lot type you’re defining and the Lot Types dialog

box is displayed.  The color you selected appears in the small square box on the left side

of the name you specified for the lot type.  Objects representing this type of

undeveloped area will be displayed in the specified color on the site plan.

11. Press the Return key.

The name you assigned is added to the list box.

Lot Types Dialog Box
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12. To specify another lot type, repeat steps 2–11.

To move the name of a lot type upward or downward in the list box, click on the name to

highlight it, and then click on the Move Up or Move Down button.

To delete a lot type, click on its name in the list box and then click on the Remove

button.

When you have defined all desired lot types, click on the OK button to save the

information and exit this function.

Assigning Lot Types to Objects on a Site Plan

This function enables you to color-code specific lots as a particular lot type, such as wooded,

waterfront, or sold.  The individual lots will be then displayed in the color you specified in the

Defining Lot Types function that we previously discussed.  You must complete that function

before you can do this procedure.

1. Click on one or more lots that you want to designate as being a particular lot type.

Hold down the Shift key to select multiple lots.  The selected lots are highlighted on the

screen, as shown in the diagram below.
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Selecting Lots to Color-Code
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2. Right-click-and-drag to select the desired lot type from the pull-down menu, as shown in

the following diagram.

Selecting a Lot Type
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The highlighted lots now appear in the designated color for the lot type you selected.  You

can do this procedure at any time to change any lot’s designated lot type.

VIEWING OPTIONS

Zoom In and Zoom Out Features

Click on the + (Zoom In) or – (Zoom Out) icon (shown below) to enlarge or reduce the size of

the site plan currently displayed in the window.

Location of Zoom In and Zoom Out Icons

Hide All Lots and Hide All Notes Options

Selecting either or both of these viewing options from the View menu (shown below) will

result in faster re-plotting of the site plan while you’re modifying it.  You can toggle these

features on and off by reselecting them from the menu.
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• Select the Hide All Lots option on the View menu to disable the display of the lots on the

site plan currently displayed on the screen.

• Select the Hide All Notes option from the View menu to disable the display of all notes on

the site plan currently displayed on the screen.

View Menu

Hiding or Displaying the Lots on a Selected Road or Cul-de-Sac

This function prevents the display of the lots along a designated road or cul-de-sac.  (The lots

are not deleted, they just don’t appear on the site map!)  This results in faster displays of the

site plan after you make changes to it.

1. Right-click on the road or cul-de-sac of interest.
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A pop-down menu appears, as shown in the following diagram.  Note that a checkmark

appears on the left side of the Display Lots menu option.  This indicates that the lot

display function is active (the lots are being displayed on the site plan).

Hiding Lots on a Selected Road or Cul-de-Sac
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2. Select Display Lots from the menu.

The checkmark on the left side of the Display Lots menu option is removed.  This indicates

that the lots along the selected road or cul-de-sac will not be displayed on the site plan.

3. To redisplay the lots, select the road or cul-de-sac, right-click, and select Display Lots

from the pop-down menu that appears.

A checkmark appears on the left side of the Display Lots menu option.  This indicates that

the lots along the selected road or cul-de-sac will be displayed on the site plan.

REFERENCE INFORMATION

Functions Available in the Main Window

The following illustration shows the SitePlanner Pro Main Window and the functions you can

access from this window.  Short descriptions of these functions appear after the illustration.
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Functional Descriptions

All functions available in the SitePlanner Pro Main Window are defined below.  This includes all

pull-down menus, icons, and toolbars.

Pull-Down Menus

File Menu options

New – Select this option to open a new site plan.

Open – Select this option to open an existing site plan.

Save – Select this option to save a site plan.

Save As – Select this option to save a copy of a site plan with a different name.

Print – Select this option to print a site plan.

Exit – Select this option to quit SitePlanner Pro.  You are prompted to save any open

site plans.
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Edit Menu options

Undo - Undo the last action.

Redo - Redo the last action.

Select All – Select this option to select all objects in a site plan.

Delete – Select this option to delete the currently selected object(s).

Properties – Select this option to display the current lot sizes and road widths.

View Menu options

Fit to Window – Select this option to reduce or enlarge the view of the currently

displayed site plan to the largest size that will completely fit in the window.

Zoom In – Select this option to magnify the view of the current site plan.

Zoom Out – Select this option to reduce the view of the current site plan.

Hide All Lots – Select this option to remove all notes from the screen display.

Hide All Notes – Select this option to remove all notes from the screen display.
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Site Menu options

Boundary – Select this option to display the Boundary Definition window.

Statistics – Select this option to display the Site Statistics dialog box.

Undeveloped Area Types – Select this option to display the Undeveloped Area Types

dialog box.

Lot Types – Select this option to define color-coded lot types.

Lock Site – Select this option to lock all current objects in a displayed site plan.
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Toolbar Icons

New– Click on this icon to open a new site plan.

Open– Click on this icon to open an existing site plan.

Save– Click on this icon to save the current site plan.

Print– Click on this icon to print the current site plan.

Properties– Click on this icon to display the current lot sizes and road widths.

Zoom In– Click on this icon to magnify the view of the current site plan.

Zoom Out– Click on this icon to reduce view of the current site plan.

Boundary Definition– Click on this icon to display the Boundary Definition window.

Site Statistics– Click on this icon to display the Site Statistics dialog box.
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Drawing Palette Icons

Selection tool – Use this tool to select (click on) one or more objects in a site plan.

Straight Road tool – Use this tool to add a straight road to a site plan.

Curved Road tool – Use this tool to add a curved road to a site plan.

Cul-de-sac tool – Use this tool to add a cul-de-sac at the end of a road in a site plan.

Undeveloped Area tool – Use this tool to add an undeveloped area to a site plan.

Note tool – Use this tool to add a note to a site plan.


